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1. Introduction 
 

  The Spatial Aspect Explorer targeted for exploring comprehensive amount of spatial data in form of 

interactive maps. The data for such representation includes both raster data and vector data. Primary 

design of the product directed for exploring big amount of spatial data, such as global coverage with 

any desired level of details with high speed of operability over the data from side of user. For meet 

the target, the program utilizes same pipeline as used in Spatial Aspect Viewer, which is other 

product of author, used for working with raster data only. More than, it reuses the entire pipeline for 

raster data from the former product for render its background layer with all respective features of 

customization from side of user.  

  The program works with proprietary vector formats of author, designed to keep data in compact 

form with high speed and selective accessibility to any desired part of data with desired level of 

details. Also the program can work with vector data in form of shape-files with extension “.SHP”, 

which commonly used in much of known programs in spatial domain. These proprietary vector 

formats permit to build separate layers as hierarchy of files from comprehensive sets of data from 

public domain for bring they to fast exploration pipeline over global coverage. Currently author uses 

his own Spatial Aspect Tools in exclusive manner for provide such layers, but in future such tools 

will be available for other users. 

  The program currently supports following map projections: 

• Geographic (longitude/latitude), also known as Cylindrical. 

• Polar Stereographic. 

Although this set of map projection can be look to narrow, it is enough for provide global 

representation of spatial data, having Digital Elevation Models (DEM) as background layer. Known 

DEM data in public domain for Earth, Moon and Mars uses only such two map projections. More 

than, the program reduces necessity of other map projections by utilizing dynamic isometrics 

behavior over Cylindrical projection, which was primary introduced in Spatial Aspect Viewer. The 

behavior reduces map distortions upon proximity to poles of a planet inside of a limited frame. 

  The program has comprehensive set of features in respect of data processing over attributes of 

shapes, which constitute their own database. Such features permit promptly request information 

about any labeled object on map, doing search over entire database of layer, and promptly navigate 

from selected object in database to its respective vicinity on map. Also such features include 

sophisticated policy of Level Of Details (LOD) for optimization appearance of separated object with 

high flexibility. And in future number of possibilities of the program will be increased. 
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2. Main Window 
 

  The main window of the program has typical explorer placement: splitting main area of window on 

left pane in respect of logical selectivity, and to right pane in respect of viewing and spatial 

selectivity.  

 

  The logical selectivity there means selectivity over particular layers of entire map. And so the left 

pane has a simple tree of entire map project, which contains a root level with title of entire map and 

child entries, which represent all layer in order of their rendering from bottom to top. Bottom most 

layer is a background, which can contains a raster data render result, or simple a color filling. Other 

entries are vector data render results. Each vector layer has a check box on left side of its icon. This 

check box permits enabling or disabling rendering of the layer. Also user can change from the pane 

entire content of the map project in respect number of layers, their order, properties of particular 

layers and respective LOD rendering policies. Additionally user can inspect database content of 

selected layer from the pane. The pane is referenced also as Project View. 

  The right pane exposes selected area of map, and so it referenced also as Main View of map. It 

provides drag and drop navigation on map and reading local information from cursor position on 

map to displaying on Status Bar. Navigation on the view is tightly bounded with navigation on 

Overview Window by feature known as “smart cursor”, which was introduced in Spatial Aspect 

Viewer. And so, all spatial navigation in Spatial Aspect Explorer is exactly same as in former 

product. The Main View consists from image part in its center, four axes around it, and canvas in 

remainder. The canvas preserves isometric aspect ratio in the middle of map. You can double-click 

the canvas for drop it in possible limits. 

  A menu bar placed on top of the main window for providing access to all commands of the 

program. 

  A main toolbar placed under main menu and can be undocked and re-docked to any other position. 
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  A navigation toolbar placed on right side of the main toolbar and can be undocked and re-docked 

to any horizontal position. The bar contains on its right side a long combo box for selection a region 

of interest. 

  A view toolbar placed on right side of main window and can be undocked and re-docked to any 

other position. 

  A Legend Bar placed across the top of main window, below toolbars. The legend bar displays 

current legend of raster layer, such as altitude. It consists from color scale and altitude scale. 

Appearance of these two features reflects automatically change of horizontal size of legend bar. A 

small black triangle arrow between two scales points to actual value of altitude under mouse 

pointer over any view of map. The legend bar can be undocked and docked to top or bottom side of 

main window. The color’s limits and limits of altitude, which used by legend bar for displaying the 

legend, are managed by scale page of Legend Manager. 

  A status bar placed at the bottom of main window. The left area of the status bar describes actions 

of menu items as you use the arrow keys to navigate through menus.  This area similarly shows 

messages that describe the actions of toolbar buttons as you move cursor over them. Also here may 

be any information corresponded to current cursor position on view. The right areas of the status bar 

indicate geographic coordinates of current cursor position on view and altitude, if raster layer is 

presented. Appearance of the status bar will differed for case of Polar Stereographic projection: two 

additional panes will appear before others, displaying inverted values of longitude and latitude 

restored from original easting and northing coordinates. 

 

 

3. Overview Window 
 

 
The overview window is displayed by default in bottom left corner of screen. The overview window 

has a tool frame and displays full view of map and smart cursor for navigation, which provides select 

of region through drag and drop operations. The window has a permanent canvas for keeping 

original aspect ratio of entire map and can be resized to any size. 

 

4. Main Toolbar 
 

The main toolbar presented below with followed description per each button. 

 

 
 

• New:       Closes this vector map project and creates a new. 

• Open…:      Opens an existing vector map project. 

• Save:       Saves this vector map project. 
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• Add layer…:      Adds layer for this vector map project. 

• Layer properties…:     Customizes properties of current layer. 

• LoD strategy…:     Defining strategy for Levels of Details (LoD). 

• Background…:      Customizes background. 

• View Bar:       Shows or hides the view toolbar. 

• About Spatial Aspect Explorer: Displays program information, version number and  

                                                         copyright.  

 

 

5. View Toolbar 
 

The view toolbar presented below with followed description per each button. 

 

 
 

• Navigation Bar:     Shows or hides the Navigation Bar. 

• Legend Bar:      Shows or hides the Legend Bar. 

• Legend Manager:     Shows or hides the Legend Manager. 

• Overview:      Shows or hides the Overview window. 

• Shape info…:      Opens a listed view of shapes database info for inspection. 

• Axes:       Shows or hides axes. 

• Grid:       Shows or hides the grid. 

• Shading:      Toggles render of shades on surface. 

• Shading only:      Toggles render only of shades on surface. 

• Color scale:      Switches between of color scales. 

• Find range:      Finds and sets range of elevations from the current view. 

 

6. Navigation Toolbar 
 

The navigation toolbar presented below with followed description per each item. 

 

 
 

• Selection & moving:     Switches to selection and moving mode with smart cursor. 

• Selection & sizing:     Switches to selection and sizing mode with smart cursor. 

• Magnify glass:      Switches to magnify glass mode. 

• Smooth zoom:      Enables smooth zoom instead sizing. 

• Zoom out step :10:     Zooms out with step :10 from current value. 

• Zoom out step :5:     Zooms out with step :5 from current value. 

• Zoom out step :2:     Zooms out with step :2 from current value. 

• Zoom in step x2:     Zooms in with step x2 from current value. 

• Zoom in step x5:     Zooms in with step x5 from current value. 

• Zoom in step x10:     Zooms in with step x10 from current value. 

• Setup of region…:     Setups of selected region. 

• Select region…:     Selects of interesting map region. 
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7. Legend Manager 
 

The legend manager is displayed in separated window with small frame by default in bottom side of 

screen.  The legend manager provides managing of current legend, including shading and consists 

from two pages: Scale page and Shade page. 

7.1. Scale Page of Legend Manager 

 
 

The Scale page consists from two main parts: 

 Color scale manager - manages limits of color, it is upper half of the window; 

 Altitude scale manager - manages limits of altitude, it is down half of the window. 

Each of those two parts contains pair of horizontal sliders. Upper slider from pair manages low 

limit. Down slider from pair manages high limit.  On left size from sliders placed long vertical 

check button for locking those two sliders together.  In lock state you can move two sliders together, 

which is doing offset two limits with constant distance between them. Color scale placed between 

each two sliders in each pair. There is distinguishing between two color scales. The color scale of 

color manager simply displays all selected color scale. By that, sliders point on limits of that scale 

for using in legend.  The color scale of altitude manager displays colors in limits assigned by color 

scale manager. By that, colors with full selected limits placed between positions of two sliders and 

all left space from low limit is in low limit color and all right space from high limit is in high limit 

color. 

  Button  placed on left side of color scale manager for change color set.  In Spatial Aspect 

Explorer currently three color sets exist: two colored scales and grayscale. These sets can be rotating 

by pressing on this button. There is additional color scale for using only with map kind of Global 

Land Cover Characteristics (GLCC) for Olson Global Ecosystems coding (OGE). There are 

shortcuts for this button in menus and on View Bar. 

  Full altitude scale placed on bottom side of altitude manager. The parts of this scale, which is 

outside sliders, are dimmed. Not dimmed internal part and two static texts on right side of each 

slider display diapason of altitudes for legend. 

  Zoom altitude control placed on bottom of altitude scale manager. It consists from two buttons: 

Zoom Out:  and Zoom In: . By the control you can assign limits of altitude with desired 

accuracy. After pressing on button Zoom In the altitude scale redraws with using selected diapason 

of altitude as full diapason. After pressing on button Zoom Out the altitude scale returns to previous 

state. The program memorizes all previous states of altitude scale in a stack. 

  Button  placed on right side of altitude scale manager for finding and setting range of altitudes. 

The finding is executed from elevation data correspondent only to actual pixels in Main View of 
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map. So this feature produced adaptive and attractive look for color data interpretation and keeps a 

time instead doing it manually by all entire controls of altitude scale manager. This feature works in 

convolution with zoom altitude control doing enough zoom automatically for leaving enough space 

for manual narrowing of altitude sliders. There are shortcuts for this button in menus and on View 

Bar. There is way to getting range from full entire map yet if the Main view of map contents only a 

part. It can be doing by executing this command from Context Menu of Overview window. But still 

the result will be sensitive from number of actual map pixels from applicable window. 

  Each change in color scale manager or in altitude manager reflects on Legend Bar and all views of 

map interactively and simultaneously. 

7.2. Shade page of Legend Manager 

 
 

  The Shade page consists from five sliders, which manage rendering of shade tones on surface: 

 Exaggeration slider - manages vertical exaggeration of surface.  High exaggeration is very useable 

for viewing details of weak expressed relief or for viewing map with high scaling. 

 Sun height slider - manages height of Sun above horizon in degrees.  The parameter together with 

Sun azimuth may be used for modeling illumination dependently from interested time and day.  

Additionally low height of Sun above horizon increases expressing of relief. 

 Sun azimuth slider - manages East-based azimuth of Sun (counter-clockwise) in degrees. The 

parameter together with Sun height may be used for modeling illumination dependently from 

interested time and day. 

 Brightness slider - manages total brightness of illumination. 

 Ambient slider - manages quote of ambient illumination in total brightness in percents.  The 

ambient illumination there constitutes from celestial light from zenith.  The high value of ambient 

illumination may be used for modeling illumination of surface with solid clouds in the sky. 

  Each change in each slider on the Shade page reflects on all views of map, which have enabled 

shading, interactively and simultaneously. 

 

8. Navigation in Spatial Aspect Explorer 
 

  The program has following common features participating in navigation, including: 

• Smart cursor. 

• Interruptible update. 

• Smooth navigation. 

  And the program has following forms of navigation: 

• Navigation with smart cursor. 

• Navigation with magnify glass. 

• Navigation with zoom-in and zoom-out commands. 



 8

• Navigation with assigned regions. 

• Navigation from database of layer. 

• Spatial navigation to database record, or object identifying. 

8.1. Smart cursor feature. 

  The smart cursor presents very useful navigation, that known also as drag and drop navigation.  The 

smart cursor is union of two things: the graphically drawn rectangular region of selection on map and 

navigation behavior in different parts across the graphic.  You can see graphics of smart cursor on 

Overview Window as it simple drawn on following picture: 

 
  Here are drawn two extremely conformations of smart cursor: 

 
  On left side is case when full map is selected, as you can see after opening of map.  On right side is 

case when only very small region of map is selected.  The following picture designates dividing 

between space of selecting and space of moving (sizing) of smart cursor: 

 
  Here space of selecting designated by blue color.  In this space you can select any region by 

pressing left button of mouse and dragging mouse to desired limits; after releasing left button of 

mouse main view of map will be redrawn with new limits.  Cyan color here designates space for 

moving (sizing).  In this space you can drag current region in any direction or you can drag any side 

of current region to desired limits.  All that depended from two things: current mode of work with 

smart cursor and position of mouse cursor relative subdivisions of smart cursor.  You can to switch 

current mode of work with smart cursor by two commands: Selection and moving and Selection 

and sizing.  The current mode is independent for each view. The following picture explains, how 

you can use selecting and moving possibilities in selection and moving mode: 
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  On the picture, three thin yellow rectangles designate different selection operations.  In one edge of 

each those rectangles you can see, as mouse cursor prompts selection.  The moving in two directions 

simultaneously is possible if you start dragging the rectangular frame of smart cursor, it is drawn by 

cyan color.  On downright edge of that frame you can see, as mouse cursor prompts bi-directional 

moving.  If you want to move region only in one direction, you can use as start point of dragging 

additional lines of smart cursor, it is drawn by green color.  On top and left additional lines of smart 

cursor you can see, as mouse cursor prompts moving by horizontal and vertical directions 

correspondingly. 

  The following picture explains how you can use sizing possibilities in selection and sizing mode: 

 
  On the picture prompts of mouse cursor are drawn on each side and edge of smart cursor.  Big 

triangles of arrows designate side or edge, which will be sized.  You can see here alternative 

possibilities for sizing sides by dragging with correspondent to each side additional lines, that is 

useful with sizing of small regions.  Parts of smart cursor, which used for sizing of sides, are drawn 

with green color. Parts of smart cursor, which used for sizing of edges, are drawn with cyan color. 

  In case of small region, dividing between one directional and bi-directional operation are drawn on 

following picture: 

 
  You can see on the picture: for each one directional operation you can use only additional lines of 

smart cursor. 

  Additionally you can use smart cursor in the mode for smooth zoom into central point of interested 

region. The useful feature is available by switching with command Smooth zoom. 

  Although smart cursor is visible only on Overview window, it exists also on Main view of map.  It 

is not visible there, because its rectangular frame placed outside that view.  However you can see its 

there if you observing the map by magnify glass view.  Also internal vicinity of borders of main 

view of map provides all described functionalities of smart cursor, which are applicable for its frame 

part.  For the case, that active area of smart cursor will provide additional feedback by modifying 

pixels colors underneath, when mouse is pressed in the area.  Action of smart cursor for this case is 

complemented by reposition pointer of mouse to place of primary click, providing very nice way for 

smooth navigation. 

8.2. Interruptible update feature. 

   The “Interruptible update” feature of navigation brings to you possibility for fast work. You don’t 

should to wait when any view of map will be updated with data from file.  You can change the 

updating job by any interaction with user interface that is intended to current update region.  For 

example, you had selected any region on map through smart cursor operation, after that, you can 

change size of window without waiting when selected region will be updated. 

  As feedback for update state there are two possibilities: you can see the progress bar on updated 

map, and you can see updating state as changing number updated horizontal lines of image from top 
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to bottom in background and progress in rendering vector graphics. You will be see, in time of 

update, image of map with level of details that is ready in current time of update.  The meaning of 

progress bar position is approximation to desired level of details. 

8.3. Smooth navigation feature. 

  The smooth navigation is following feature: you can do dragging any part of smart cursor or 

magnify glass view, and the program will display in that time the entire map with updated content. 

This feature based on “Interruptible update” feature and enabled always. Opposition to smooth 

navigation will be updating content only after releasing mouse button, as it occurred by using 

selection action. 

8.4. Navigation with smart cursor. 

  There are much of variants using this feature: 

• Selection in overview window. 

• Moving in overview window by frame or centerlines. 

• Sizing in overview window by frame or centerlines on respective side. 

• Doing smooth zoom in overview window by frame or centerlines. 

• Selection in main view. 

• Roaming in main view by dragging its frame. 

• Sizing content area in main view by dragging respective side of its frame. 

• Doing smooth zoom in main view by dragging any side of its frame. 

8.5. Navigation with magnify glass. 

  The magnify glass mode is complemented mode to mode of working with smart cursor.  In this 

mode the smart cursor disabled and mouse cursor is following: 

 In this mode you can observe current region by magnify glass view for viewing additional 

details in areas of interest. 

 
  You can move this view by pressed state of left button of mouse in limits of surface of full screen 

and view map area that continues from current region also.  The magnifying is 3 times.  You can see 

with magnify glass view grid and smart cursor itself. 

  This mode is independent for each view. 

8.6. Navigation with zoom-in and zoom-out commands. 

  Zoom-in and zoom-out commands change bounding limits of current region.  By that, current 

center of region isn’t changing and its extents increasing or decreasing.  There are following zoom-in 

and zoom-out commands: 

• Zoom out step :10. 

• Zoom out step :5. 

• Zoom out step :2. 

• Zoom in step x2. 
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• Zoom in step x5. 

• Zoom in step x10. 

Also zoom can be changed through small steps commands by using wheel of mouse in a view having 

focus. The minimal zoom step in this case is about 20 percents. 

8.7. Navigation with assigned regions. 

  You can navigate by selecting any previously assigned region from combo box of regions on 

Navigation toolbar. 

8.8. Navigation from database of layer. 

  In many cases of working with layers composed map, user want to find a specific object of interest, 

which can be small on very big map. The program permits do it by following steps: 

1. User selected a layer in Project View, in which the object of interest exists. 

2. User executes Shape Info… command and opens the listed view dialog of shapes database 

info. 

3. User performs search of the object of interest in the table of database by its name. 

4. User executes Navigate to command from the dialog window, which can be executed by 

simple double-click. 

  Upon the last request, program will identify spatial position of the object, which record was 

selected, will calculate optimal extent of the desired view, and will apply the generated region of 

interest to render pipeline. 

8.9. Spatial navigation to database record, or object identifying. 

  The feature is reversed for previous kind of navigation. Consider user want get comprehended 

information about some object, which label or centered symbol user sees on map. For that, user can 

simple double-click on the label or centered symbol, and the listed view dialog of shapes database 

info will appear, having record for that object selected. The action will be smooth, if the object of 

interest exists in selected layer. In some cases it can be problematic for user, since number of layer 

can be big. For the case, user can select the project root item or background item in the Project 

View, and the program will identify the layer also. The last will accompany by message box, with 

explanation about using the feature on smooth way. The necessity of pre-selecting a layer permits 

additional level of selectivity for maps with crowded placement of objects on map from multiple 

layers. 
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9. Shape Info dialog box 
 

  Each vector layer has a database, which consists from only one table, where for each particular 

shape exists a record over a number of attributes, correspondent to columns of such table. Content of 

such table mainly used upon rendering of the layer, especially for rendering names of shapes, if they 

exist. But also its content can have an interest for user. For such purposes the Shape Info dialog 

window exists. 

  The dialog raised by Shape info… command from View menu or toolbar for a layer selected in 

Project View. It appears by default in center-bottom position of screen. 

 
 

  The dialog consists from: 

  List control is placed from bottom of the dialog. Its size can be changed upon changing entire size 

of the dialog. Content of the list control reflects entire content of the table of respective layer. It has a 

header wit columns, reflected names of respective attributes, and first column there is simple record 

counting number. User can sort entire records upon clicking on respective column, and sort direction 

will be toggled between ascending and descending upon the click. 

  Find What edit box is placed over top of the dialog. User can enter there a string for find a record 

of interest. 

  In column combo box is placed under left side of the edit box. User can select there a column for 

search. Also options <Any column> exists there. 

  Search combo box is placed under center of the edit box. User can use it to switch direction of 

search between “down” and “up”. 

  Match combo box is placed under right side of the edit box. User can select there a match option 

from set of “Start of Field”, “Whole Field” and “Any part of Field”. 

  Match case check box is placed under left side of the first combo box. User can select there case-

sensitive search. 

  Find first button is placed under second combo box. User can press it for initiate the search. 

  Find next button is placed on right from the previous button. User can press it for continue search. 

  Navigate to button is placed on right from the previous button. User can press it for navigate to 

shape of selected record of interest. The dialog will not closed upon this action. Also the command 

can be executed upon double-click on record of interest. 

  Record info… button is placed under right side of first combo box. User can press it for viewing 

values of attributes of selected record in separated Record’s Info dialog box.  
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9.1. Record’s Info dialog box. 

   
 

  The dialog consists from: 

  Big edit box, which displays content of record in multi-line field: Value form. User can copy from 

there any part of its content. 

  Close button, for closing the dialog. 

 

 

10. Setup of region dialog box 
 

  The dialog raised by Setup of region… command from Navigation menu or toolbar. It appears by 

default in center position of screen. 
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  The dialog provides possibility for assigning or changing parameters of selected region.  It consists 

from two symmetrical group boxes, which present bounding rectangles: 

  Stored rectangle - the rectangle previous the change. 

  Current rectangle - the proposed rectangle. This rectangle is current rectangle from view in time 

of opening the dialog. 

Coordinates of rectangles are in geographic system of coordinates (1 unit = 1°).  Two corners specify 

each rectangle: 

  Top left corner - the northwest corner. 

  Bottom right corner - the southeast corner. 

Each corner is specified by Longitude and Latitude in two forms: with decimal dot and subdivided 

by minutes and seconds. 

Name of region text box used for assigning name for new region or for changing the existed region. 

OK button enabled only if two rectangles are same, and stored region was been changed by >Apply 

button or if here is new region or if name of existed region was been changed.  This feature preserves 

user from mistakes by changing bounding limits of existed region. 

Apply< button used for back pass stored rectangle to current rectangle and for exact equilibrium 

with new applied value, which can be differ due small errors of rounding values upon fetching to 

machine representation. 

Apply on view button used for testing of changed current rectangle. 

Two Restore buttons for each rectangle are used for having possibility undoing operations to status 

in time of opening the dialog. 

Enabling all buttons for applying and restoring defined by logic based on changed state. 

The dialog has a simpler appearance for case of working on maps with other projections. For these 

cases Easting and Northing will appear instead of Longitude and Latitude. 

 

 

11. Working with regions 
 

  The regions functionality permits promptly navigate to any pre-assigned region of interest. It was 

introduced in Spatial Aspect Viewer, where all information about regions stored in separated region 

files with extension “.rgn”, which can be loaded on explicit way or on implicit. The explicit way 

means: user can specify particular region-file for load a particular collection of regions by using 

command from menu. The implicit way means: the Spatial Aspect Viewer will automatically load a 

file with name “regions.rgn” from root directory of a raster map upon its opening. And in case of 

missing the file it can load file with same name from folder of program. That flexible behavior 

permits accumulate in one region-file collection of regions suitable for multiple raster maps. But that 

also creates a drawback: some regions from one raster map can be meaningless for other, or more 

worst, they can be from different map projections. The last drawback was been mitigated by filtering 

regions on basis of current map projection and extent of entire map. But possibility of bad mixing 

regions from different planets remained. 

  The Spatial Aspect Explorer uses other way for regions pipeline. The program can render maps 

without raster layer at all. But also for this case it need a way for loading regions implicitly. And so it 

uses Vector Map Project file (.VMP) of entire map project for storing the collection of regions also 

with other kind of information. On other side, the program reused all functionality for explicitly 

managing region-files from former program, including loading, saving and merging. More than, 

upon saving entire project file, all region information will permanently filtered on basis of current 

map projection and extent of entire map. After that, user can save the filtered content to a particular 

region-file for having the decomposed version of region for using in former program too. And so this 

way permits exchange regions collections between separated map projects. 

  All commands for managing region-files are placed in submenu Regions of File menu. 

 

 



 15

12. Edit map title dialog box 
 

  The dialog raised by Map title… command from Edit menu. 

 
 

  The title edited from this dialog box will be displayed on root entry of tree of entire map project and 

in title of Main window. 

  The dialog consists from: 

  Map title edit box used for editing the title. 

  OK button will dismiss the dialog and apply the title. 

  Cancel button will dismiss the dialog. 

 

13. Managing space of entire map 
 

  In much cases managing space of entire map used upon creating a new map. Initial map is 

referenced for Earth with Geographic projection and has space from -180° to 180° in longitude, and 

from -90° to 90° in latitude. But is should be changed for particular maps. Two dialog boxes exist for 

accomplish the task and one automatic option: 

13.1. “Apply projection as of” dialog box. 

  The dialog raised by Apply projection… command from Edit menu. The command enabled only 

for empty map, because other case means: data in all existed layers should undergo transform on 

permanent basis (i.e. edit and save) or on dynamic basis (i.e. runtime transform upon rendering). 

Both of such ways are out of scope and operational model of the program, and so this command 

disabled for non-empty project. 

 
 

  The dialog has a dual use. First is: only assign a referenced planet for Longitude/Latitude 

projection. Second is: do all, including change to other projection with respective parameters.  

The last case pictured on the image for assigning projection for Antarctica. 

  The dialog consists from: 

  Kind combo box on up used for selecting particular projection. It has only two variants: 

“Longitude / Latitude (keep and change reference planet only)” and “Polar Stereographic”. 
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  For combo box under left side of first combo box used for selecting particular planet or celestial 

body. It has only variants: “Earth”, “Moon”, “Mars”, “Mars, Polar radius”, Venus” and “Mercury”. 

  True scale latitude edit box under right side of first combo box used for assign parameter of true 

scale latitude for Polar Stereographic projection. It will be disabled for other case of projection. 

  “Cutoff aligned limit, km” edit box under second combo box used for assign extent of map. The 

parameter is half of side of quad with center on pole. It will be disabled for Longitude/Latitude 

projection. 

  OK button will dismiss the dialog and apply selected projection on entire map, setting current 

zoom area to full extent of map. 

  Cancel button will dismiss the dialog. 

13.2. Automatic projection option. 

  The option exercised each time when a layer will load by map. The layer’s file can have 

information about projection to which it pertains. The program will propagate this information to 

entire map, considering the map should conform to all used layers in respect of projection. So 

actually first layer will trigger the task. Using layers, which aren’t conforming to each other in 

respect of projection, will lead to adverse result. The option doesn’t change limits of entire map, so 

user should do it manually for non-satisfied result. This options isn’t in use when layer is simple a 

SHP-file, also if it has accompanied PRJ-file. 

13.3. Map Limits dialog box. 

  The dialog raised by Map Limits… command from Edit menu. 

 
 

  The dialog consists from two group boxes specify two corners of map limits rectangle: Top left 

corner and Bottom right corner. Each corner is specified by Longitude/easting and 

Latitude/northing in two forms: with decimal dot and subdivided by minutes and seconds for case 

of Longitude/Latitude projection. Set buttons used only for enforce validating of respective values. 

  From shapes button used for generate limits, as union of all bound rectangles of each layer 

constitutes map, considering each such rectangle is union of all bound rectangle of each shape object 

in such layer. 

  Longitude/Latitude check box is already disabled and used only for indication for kind of used 

projection. 

  Apply button used for applying modified rectangle of limits on entire map. It is enabled only if 

user was beginning modification. 

  OK button applies modified rectangle of limits on entire map and dismiss the dialog. 

  Cancel button will dismiss the dialog. 
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14. Background dialog box 
 

  The dialog raised by Background… command from Edit menu or by double-click Background 

entry in project tree. 

 
 

  The dialog consists from: 

  Type group box with two radio buttons Solid and File. It used for select type of background. The 

“Solid” means: a solid color will be used as background. The “File” means: content of selected raster 

file will be used as background. 

  A button with external label Color, indicates color for background if type “Solid” selected and 

permits peek it. In other case it will be disabled. Pushing the button will raise standard Color dialog. 

  A read-only File edit box indicates file path for background. It enabled only if type “File” is 

selected. 

  A button … on right side of  the “File” edit box permits selection file for background. It enabled 

only if type “File” is selected. Upon pressing the button standard-look “Select raster file” dialog 

box for file opening will appear. The dialog box has list Files of Type combo box contains following 

entries: 

Spatial Aspect Map Files: *.spm - main file for set of map contained *.spe or *.zrs files. 

Spatial Aspect Data Files: *.spe - separated map files in proprietary high compressed format; 

                                          *.zrs - separated map files in proprietary high compressed format, 

                                          which stands as Zipped Raster Set, opened for public exploration 

                                          and use; 

               BIL DEM Files: *.bil;*.dem - Byte interleaving files, as it is in GTOPO30 collection, with 

                                          providing correspondent *.hdr file. 

Goddard SFC Image Files: *.img - Byte interleaving files, as it is in GTOPO30 collection, but with 

                                           extended set of sample types and modalities, and also with providing  

                                           correspondent *.lbl file, having content in accordance with PDS 

                                           specification. Also program will look for correspondent *.hdr file for 

                                           override the *lbl file, and can open some lunar files without header-files 

                                           at all. 

                 SRTM Files: *.hgt - Byte interleaving files, as it is in GTOPO30 collection but without 

                                           header. The name of file designates bottom-left corner of image. 

                                          *.hgt.bin - Like as .hgt files but with internal header, which is ignored. 

                                          *.hgt.zip - Zipped version of .hgt file or .hgt.bin file. 

                                          *.srtm - Some version, having *hdr file, like files of GTOPO30 

                                          collection. 

           USGS DEM Files: *.dem, *.250, *.1, *.24 - All USGS DEM files, except of having UTM     

                                           projection. 

            SDTS DEM Files: *.ddf - DEM files in SDTS format, except of having UTM     

                                           projection. 

                    Bitmap Files: *.bmp – regular bitmap files. 
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  A checkbox, which instructs to render NODATA values with color of zero-level. By default the 

program renders values specified with NODATA attribute in raster file with blue color, which is 

used for ocean representation. It is OK, when this value is outside of possible range of altitudes, like 

“–9999”, as for GTOPO30 data. But SRTM files use “0” value for it. So there exists a problem for: 

distinguish ocean level samples from zero-level samples inside inland area. But in the program, 

vector layers can have ocean mask, which can resolve the problem. And for this case the check box 

should be select for disable said blue-color rendering of ocean in raster layer. Practically, the feature 

works no much well, because the mask is too coarse, doesn’t exact correspondent to raster data, 

introduced additional delay in rendering and amount of inland zero-values are too small. So this 

feature is almost never in use. Nevertheless, user can decide apply the feature upon looking on some 

particular area. 

  Apply button used for applying modified property of background on map. It is enabled only if 

exists difference in such changes. Result of this applying will be also reflected in text of 

Background entry on Project View pane of Main Window. The text will describe current modality 

for the background. It accompanied by appropriate switching to respective profile of work for the 

background, changing appearance of other elements of user interface too. 

  OK button applies modified property of background on map and dismiss the dialog. 

  Cancel button will dismiss the dialog. 

 

 

15. Raster file properties dialog box 
 

  The dialog raised by Raster file properties… command from File menu or from Context menu of 

map view. 

 
 

The dialog consists from: 

  Big edit box, which displays content of record in multi-line field: Value form. User can copy from 

there any part of its content. Content of this edit box will depend from kind of raster map and its 

projection. For .spm-file, which points on set of maps, all pixels related information will be omitted, 

and statistics is approximated, because it goes from first raster file with overall coverage. 

  Close button, for closing the dialog.
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16. Layer properties dialog box 
 

The dialog raised by Layer properties… command from Edit menu or main toolbar for selected 

layer or by double-click particular layer entry in project tree. The dialog used for inspect and edit 

properties of selected layer and consists from 6 pages: 

• Shape file 

• Borders 

• Interior 

• Centered symbols 

• Labels 

• Sort order 

  Also the dialog has three buttons: 

  Apply button used for applying modified property of the layer on map. It is enabled only if 

difference exists between new state and current state of properties. 

  OK button applies modified property of the layer on map and dismiss the dialog. 

  Cancel button will dismiss the dialog. 

16.1. Shape file page 

 
 

The Shape file page consists from: 

  Shape file name read-only edit box reports currently selected file. “Shape file” has generic 

meaning there: it is not only files with extension “.shp”, but also other formats too, which conform 

with the shape-file format in respect of keeping data, loaded from a shape-file, without loss of 

geometry and database information. 

  A button … under right side of  the edit box permits selection the file. Upon pressing the button 

standard-look “Select vector data file” dialog box for file opening will appear. The dialog box has 

list Files of Type combo box contains following entries: 

          Vector Map Layer: *.vml - separated vector data file in proprietary high compressed format,  

                                            which used vector quantization algorithm for compressing geometry data  

                                            and filtering for particular LOD. 

                     Shape Files: *.shp - standard shape-file as set of 3 files with extension “shp”, “dbf” and 

                                           “shx”. 

    Optimized Map Layer: *.oml - proprietary format root file referenced to collection of shape  

                                            coverages with different LODs, kind of  “.vml” or “.tml”, originated from  
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                                            common shape-file. 

            Tiled Map Layer: *.tml - proprietary format root file referenced to collection of shape  

                                            coverages with common LOD, kind of “.vml”, originated from common  

                                            shape-file and represented shapes from different tiles in respect of the  

                                            original file. 

                           All files: *.* - the is common type. The program recognizes type of file  

                                          automatically. 

Other pages of the dialog have properties bind to particular attributes of shapes database upon user’s 

selection. Changing of shape file there will lead to resetting those selected attributes to first field. So 

user should correct back selection of all that attributes on other pages manually after changing 

of shape file! The program will stay away from any automatic correction of it, because old attributes 

couldn’t exists in a new file, and only user can do decision about their use. 

  Legend name edit box contains descriptive legend of the layer, which can be edited. The legend will 

be displayed as text of tree entry of the layer. For new layer the legend is empty. For the case, title of 

selected shape file will be displayed instead it. Only “.oml” and “.tml” can have the legend. For other 

files, full path to the file will be displayed as text of tree entry for new layer. 

16.2. Borders page. 

 
 

  The Borders page applicable for all kinds of shapes and consists from: 

  Enabled check box used for enable rendering of borderlines of shapes. When the check box is not 

set, all others controls on the page are disabled. 

  Color picker button used for select a color for lines. Pushing the button will raise standard Color 

dialog. 

  Width combo box used for select width of lines. 
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16.3. Interior page. 

 
 

  The Interior page is not applicable for shapes kind of point or line, and will be disabled for such 

cases. The page consists from: 

  Enabled check box used for enable rendering of interior of shapes. When the check box is not set, 

all others controls on the page are disabled. 

  Color picker button used for select a color for brush of interior. Pushing the button will raise 

standard Color dialog. 

  Hatch combo box used for select hatch of brush of interior. 

  “Rotate colors” check box used for enable selection of color dependently from value of particular 

attribute of shape. Colors for it will be selected for internal predefined list. Mapping between that 

value and color will performed by simple algorithm of circular mapping by modulo of length of the 

list. The color picker button will be disabled, when this check box is set. 

  “Color map by field” combo box used for select the particular attribute column for the “rotate 

colors” feature, and will be enabled only if its check box is set. 

16.4. Centered symbols page. 

 
 

  The Centered page applicable for all kinds of shapes and consists from: 
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  Enabled check box used for enable rendering of centered symbol on centroid position of shapes or 

tied to their labels. When the check box is not set, all others controls on the page are disabled. 

  Symbol picker button used for select of particular centered symbol through using Centered 

symbol dialog box. 

  “With labels only” check box permits tying centered symbols with labels. 

  “Not overlapped” check box permits joining centered symbols to common “non-overlapping” 

policy of entire view. The check box will be disabled, when “With labels only” option is selected, 

because control of the feature will move to side of labels. 

 

16.5. Labels page. 

 
  The Labels page applicable for all kinds of shapes and consists from: 

  Enabled check box used for enable rendering of labels of shapes. When the check box is not set, 

all others controls on the page are disabled. 

  “By field” combo box permits selection of specific attribute values for content of labels. It contains 

list of all attribute names. 

  Font picker button permits selection of particular system font trough using standard Font dialog. 

  “X-offset field” combo box permits selection of specific attribute values as horizontal component 

of position of label. It contains only numerical attributes. The ~ button over right side of the control 

assign empty selection for it, against using explicit offset specification. 

  “Y-offset field” combo box permits selection of specific attribute values as vertical component of 

position of label. It contains only numerical attributes. The ~ button over right side of the control 

assign empty selection for it, against using explicit offset specification. When explicit offset isn’t in 

use, an implicit position will be used. Generally it is position of centroid. But it is strict only for 

shapes kind of point. For other cases program tries to find best position for maximally entering the 

labels inside field of view of user, which perceived as “label attraction” feature. Also angular 

position of label will specified explicitly upon having “TEXT_ANGLE” attribute in shapes database 

table. In other case the angle will be “0°”, except of shapes kind of arcs. For the case, program will 

calculate the angle automatically, for having labels along arcs. 

  “Horizontal alignment” combo box permits select horizontal alignment of labels relative their 

default positions. It has values “Left”, “Center” and “Right”. 

  “Vertical alignment” combo box permits select vertical alignment of labels relative their default 

positions. It has values “Top”, “Center” and “Bottom”. 

  “Not overlapped” check box permits joining labels to common “non-overlapping” policy of entire 

view. 
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  “Alignment by centered” check box permits having additional displacement of labels in direction 

specified by alignment combo boxes on value about half size of used centered symbol. 

  “Allow duplicated” check box permits having multiple labels with same text for the layer. 

  “Adaptive color” check box permits having colors of labels be complementary to color of interior. 

The check box enabled only for shapes kind of polygons. 

 

16.6. Sort order page. 

 
 

  The Sort order page applicable for all kinds of shapes, but enabled only if centered symbols or 

labels are selected for rendering, when sorting of shapes has meaning. The page consists from: 

  Group of radio buttons including: 

  “By bound rectangle” radio button selects sorting by area of bound rectangle of particular 

shapes. It is disabled for shapes kind of points. 

  “By field” radio button selects sorting shapes by value of particular attribute. Selection this case 

will enable a combo box on right side, which contains numerical attributes for selection. 

  “Ascending” check box permits switch to ascending direction of sorting instead of default 

descending. 
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17. Centered symbol dialog box 
 

  The dialog raised by pressing “Symbol picker button” on “Centered” page of properties dialog box. 

 
 

  Centered symbols are vector graphic objects stored in a file with extension “.csy”, in proprietary 

format of author. The program uses “default.csy” file for its work, by loading the file from program 

directory upon start. The Centered symbol dialog permits selection particular symbol with specified 

parameters. The dialog consists from: 

  Symbol list box graphically displays all existed symbols and permits selection one of it.  

  “Select size” combo box permits selection of particular size of the symbol, which equal to height 

of quad area of the symbol. 

 Ambient color picker button used for select a color of the symbol. Pushing the button will raise 

standard Color dialog. The symbol also can have other, its own, colors for particular areas of it. And 

so word “Ambient” reflects this limitation of color assigning. 

  Preview group box has in its center result of rendering of selected symbol with selected size and 

color. 

  OK button saves the modified property of used centered symbol and dismiss the dialog. 

  Cancel button will dismiss the dialog. 
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18. LoD Strategy dialog box 
 

  The dialog raised by LoD strategy… command from Edit menu or from main toolbar for selected 

layer. 

 
 

  Level of details used in entire LoD pipeline is a number from 1 to 24, which corresponds to relation 

of size of screen to angular extent mapped to it upon fitting specific region of interest to entire 

screen. So this number can be calculated for each particular fitting a particular region of interest to 

actual view area. The number will invariant for Longitude/Latitude projection and has a specific 

angular extent, which corresponds to size of pixel. The angular extent can be mapped for absolute 

extent in meters for each planet. The program calculates the LoD number also for other projections 

using referenced radius of planet. 

  The LoD Strategy dialog box consists from (in logical order): 

  Two sliders LoD min and LoD max, which manage range of LoD numbers, used as gate for enable 

rendering the particular layer in overall. 

  Other controls are servicing for logic of resolve decision about render or not particular shape, which 

consist from: 

  Strategy group box has two radio buttons: Overall and Per LoD for select one of two strategies. 

The “Overall” strategy uses a common script for evaluate decision about rendering. Result value 

returned by the script is a cutoff LoD number. So examining shape will not rendered, if actual LoD 

number of view is above this returned number. Default script content for the case is “0”. Typical 

example of the script is simple reference on attribute field, which contains the cutoff LoD number. 

The “Per LoD” strategy uses separate script for each LoD. Result value returned by each script is a 

Boolean value or chaining instruction. The last used for simple redirect to script of next higher level 

of details. The chaining instruction is simple a number on 1 smaller than tested LoD number. By 

default all LoD specific scripts are populated with content from this chaining number only. 

  LoD combo box listed all 24 LoD numbers with respective angular and absolute extents and used 

for switch between LoD specific scripts. The combo box will be disabled for overall strategy. 

  Script read-only edit box displays text of script for particular LoD or overall strategy. 

  Edit… button used for edition the script in sophisticated editor of Script editor. 

  OK button applies modified LoD strategy of the layer on map and dismiss the dialog. 

  Cancel button will dismiss the dialog. 
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19. Script editor 
 

  The dialog box used for edition particular script of LoD strategy policy. It can be raised by pressing 

“Edit” button in “LoD strategy” dialog box. 

 
  The Script editor consists from: 

  Fields list box lists all fields of database table of current layer in natural order. When user double-

click particular item, it will be copied to cursor position of Script edit box. 

  “Functions and operators” list box lists all functions and operators for using in script syntax. 

When user double-click particular item, it will be copied to cursor position of Script edit box. 

  Prompt pane provides description of each selected item in “Fields” and “Functions and operators” 

list boxes. 

  Script edit box used for edition text of script. It performs provisional analyze the text, and renders 

separated parts of text by different colors, dependently from their context, such as operators, strings 

and numbers. Also it recognized comments in both forms: on separated lines “//” and on fragments 

“/*  …  */”.  

  Compile button used for testing the script upon compilation text of script into a “runtime form” 

and trying to evaluate it. Result of this operation will be displayed in a message box as value, error or 

warning. The last is for case when fields used in script, which can be evaluated only in runtime. 

  OK button saves the modified text and dismiss the dialog. 

  Cancel button will dismiss the dialog. 

 



 27

 

20. Menu commands reference 
 

  The main menu has keyboard shortcut Alt. All menu categories include: 

20.1. File menu. 

 

New 

Use this command to close opened vector map project and create a new. You can also close it by 

using the Close icon on the program's window or by use Exit command. 

 Shortcuts: Main Toolbar:  Keys: Ctrl+N 
Open… 

Use this command to open an existing vector map project with extension “.vmp” or to open a shape 

data file inside of new vector map project from set of types listed for Add layer… command of Edit 

menu. 

 Shortcuts: Main Toolbar:   Keys: Ctrl+O 
Save 

Use this command to save opened vector map project to its current name and directory. 

 Shortcuts: Main Toolbar:   Keys: Ctrl+S 
Save As… 

Use this command to save opened vector map project with a new name or in alternative location. 

Vector file properties… 

Use this command to view properties of vector file of current layer. 

Raster file properties… 

Use this command to view properties of raster file of the map in its background. 

Regions 

Submenu: 

Load… 

Use this command to load placement of regions from an existing file with extension “.rgn”. 

Merge To… 

Use this command to load alternative placement of regions from an existing file with 

extension “.rgn”, and merging with current. After merging all current regions with name, that 

is same with name from specified file, will be overridden with data from specified file. After 

merging the specified file will be overwritten. This command is useful if you want add to any 

existed file of placement new regions from current placement. If here is any region with 

changed placement, you should use the Merge From… command. 

Merge From… 

Use this command to add, as merging, placement of regions from an existing file with 

extension “.rgn”. After merging, all regions from specified file with name, that is same with 

name from current placement, will be overridden with data from current placement. After 

merging, current file will be overwritten if it assigned. This command is useful if you want 

build common placement from severe placement files. 

Save As… 

Use this command to save placement of regions in specified location as file with extension 

“.rgn”. 
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File information… 

Use this command to display About file of regions dialog.  This dialog displays name of 

current file of regions and number regions in the file. By default current file isn’t assigned, 

and the dialog displays number of regions in current vector map project. 

Exit 

Use this command to end your Spatial Aspect Explorer session.  You can also use the Close 

command on the application Control menu. 

 Shortcuts:  Keys: Alt+F4 
 

20.2. Edit menu. 

 

Add layer… 

Use this command to add layer to this vector map project. This command begins from opening Add 

dialog box, which is kind of standard open file dialog. The dialog box has list Files of Type combo 

box contains following entries: 

    Optimized Map Layer: *.oml - proprietary format root file referenced to collection of shape  

                                            coverages with different LODs, kind of  “.vml” or “.tml”, originated from  

                                            common shape-file. 

            Tiled Map Layer: *.tml - proprietary format root file referenced to collection of shape  

                                            coverages with common LOD, kind of “.vml”, originated from common  

                                            shape-file and represented shapes from different tiles in respect of the  

          Vector Map Layer: *.vml - separated vector data file in proprietary high compressed format,  

                                            which used vector quantization algorithm for compressing geometry data  

                                            and filtering for particular LOD. 

                     Shape Files: *.shp - standard shape-file as set of 3 files with extension “shp”, “dbf” and 

                                           “shx”. 

                                            original file. 

Layer from Shape Coverage: *.shc - format used by Spatial Aspect Tools for preparing end-to-use 

                                          shape data file. The file can reference one of four above-mentioned kinds 

                                          of file data, and has properties and LOD policy, which will be imported to 

                                          the new layer. 

Layers from Vector Map Project: *.vmp – all layers will be imported, instead adding one layer, in  

                                          their original order and with full features, such as properties and LOD 

                                          policy. 

                           All files: *.* - the is common type. The program recognizes type of file  

                                          automatically. 

Adding any new layer by this command will exercise Automatic projection option (see 12.2). 

except of shp-files. So all layers should be in common map projection and for same planet. 

 Shortcuts: Main Toolbar:  
Clone layer 

Use this command to clone current layer and add to this vector map project. 
Delete layer 

Use this command to delete current layer from this vector map project. A message box for 

confirmation this action will be raised. 

 Shortcuts: Keys: Delete 
Toggle layer 

Use this command to toggle rendering state of current layer. Check box of tree entry for the current 

layer will be toggled too. A check mark appears next to the menu item when the current layer is 

toggled on. 

 Shortcuts: Keys: Space 
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Move layer 

Submenu: 

Move to Top 

Use this command to move current layer to top. 

Move Up 

Use this command to move current layer to up on one position. 

 Shortcuts: Keys: Shift+Up 
Move Down 

Use this command to move current layer to down on one position. 

 Shortcuts: Keys: Shift+Down 
Move to Bottom 

Use this command to move current layer to bottom. 

Layer properties… 

Use this command to view properties of current layer for inspection and edition. This command 

raises Layer properties dialog box. 

 Shortcuts: Main Toolbar:  
LoD strategy… 

Use this command for defining strategy for Levels of Details (LoD) of current layer. This command 

raises LoD strategy dialog box. 

 Shortcuts: Main Toolbar:  
Map title… 

Use this command to edit title of the map. This command raises Edit map title dialog box. 

Background… 

Use this command for customize background. This command raises Background dialog box. The 

command also will be called by double-click Background entry in project tree. 

 Shortcuts: Main Toolbar:  
Map limits… 

Use this command for inspect an change limits of the map. This command raises Map Limits dialog 

box. 

Apply projection… 

Use this command to apply a projection on the map, including change of referenced planet. This 

command raises “Apply projection as of” dialog box. The command is enabled only for empty 

vector map project. 

 

20.3. View menu. 

  

Main Toolbar 

Use this command to display and hide the Main Toolbar, which includes buttons for some of the 

most common commands in the program, such as Open.  A check mark appears next to the menu 

item when the Main Toolbar is displayed. 

View Bar 

Use this command to display and hide the View Bar, which includes buttons for toggle view features 

of the program, such as View Legend Manager. A check mark appears next to the menu item when 

the View Bar is displayed. 

 Shortcuts: Main Toolbar:  
Status Bar 

Use this command to display and hide the Status Bar, which describes the action to be executed by 

the selected menu item or depressed toolbar button, and cursor spatial state.  A check mark appears 

next to the menu item when the Status Bar is displayed. 
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Navigation Bar 

Use this command to display and hide the Navigation Bar, which includes buttons for navigation 

features of the program, such as Zoom in step x2. A check mark appears next to the menu item when 

the Navigation Bar is displayed. 

 Shortcuts: View Bar:  
Legend Bar 

Use this command to display and hide the Legend Bar, which displays current legend of altitude. A 

check mark appears next to the menu item when the Legend Bar is displayed. 

 Shortcuts: View Bar:  
Legend Manager 

Use this command to display and hide the Legend Manager, which contains set of controls for 

managing current legend of altitude. A check mark appears next to the menu item when the Legend 

Manager is displayed. 

 Shortcuts: View Bar:  
Overview 

Use this command to display and hide the Overview window, which displays full view of map and 

smart cursor for navigation. A check mark appears next to the menu item when the Overview 

window is displayed. 

 Shortcuts: View Bar:  
Shape info… 

Use this command to display and hide the Shape Info dialog box, which displays a listed view of 

shapes database info for inspection. 

 Shortcuts: View Bar:  
Axes 

Use this command to display and hide axes, which are placed on each side of main view of map. A 

check mark appears next to the menu item when these axes are displayed. Each of ticks and labels of 

axes calculated and formatted automatically. 

 Shortcuts: View Bar:  
Grid 

Use this command to display and hide the grid, which is placed over main view of map. A check 

mark appears next to the menu item when the grid is displayed. Lines of grid are drawn 

correspondingly to each labeled tick mark of axes.  This command is disabled, if axes not selected. 

 Shortcuts: View Bar:  
Shading 

Use this command to toggle rendering of shades on surface. The shading rendering combined with 

current color legend. You can use Shade page of Legend Manager together with Scale page for 

changing parameters of the rendering. The command is independent for Main View and Overview. 

For the last it is applicable only through Context Menu. A radio-button mark appears next to the 

menu item when the “shading” is turned on. The command is enabled only for Digital Elevation 

Model profile. 

 Shortcuts: View Bar:  
Shading only 

Use this command to toggle for rendering only of shades on surface. In the rendering mode shading 

not combined with current color legend, and color legend is not in use. You can use only Shade page 

of Legend Manager for changing parameters of the rendering. The command is independent for 

Main View and Overview. For the last it is applicable only through Context Menu. A radio-button 

mark appears next to the menu item when the “shading only” is turned on. The command is enabled 

only for Digital Elevation Model profile. 

 Shortcuts: View Bar:  
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Color scale 

Use this command to switch between color scales from existed set. This command is a simple 

shortcut for same button on the Scale page of Legend Manager. 

 Shortcuts: View Bar:  
Find range 

Use this command to find and set existed range of elevations. This command is a simple shortcut for 

same button on the Scale page of Legend Manager. The placing of this shortcut on toolbar permits 

more comfortable way for using it. Additionally you can use this command from Context Menu of 

Overview window for getting the range from full boundary of entire map. 

 Shortcuts: View Bar:  
 

20.4. Navigation menu. 

 

Selection & moving 

Use this command for switch to selection and moving mode of work with smart cursor.  In this mode 

you can navigate by selection observed region in or out smart cursor, also you can move the smart 

cursor. This command is independent for each view. 

 Shortcuts: Navigation Toolbar:  (Main view only) 

 Keys: SHIFT+S, SHIFT( ), CTRL( ) 
Selection & sizing 

Use this command for switch to selection and sizing mode of work with smart cursor.  In this mode 

you can navigate by selection observed region in or out smart cursor, also you can change size of 

region by smart cursor. This command is independent for each view. 

 Shortcuts: Navigation Toolbar:  (Main view only) 

    Keys: SHIFT+Z, SHIFT( ), CTRL+SHIFT( ) 
Magnify glass 

Use this command for switch to magnify glass mode.  In this mode you can observe current region 

by additional magnify glass view for viewing details. This command is independent for each view. 

 Shortcuts: Navigation Toolbar:  (Main view only) 

 Keys: SHIFT+M, CTRL( , ) 
Smooth zoom 

Use this command to enable smooth zoom instead sizing in “selection and sizing” mode of work 

with smart cursor.  With the option you can change size of region with fixed aspect ratio between 

horizontal and vertical extents, having center of view fixed also. This command is independent for 

each view. 

 Shortcuts: Navigation Toolbar:  (Main view only) 
Zoom out step :10 

Use this command to enlarge zoom field in 10 times in two directions. This command is unavailable 

if current field of zoom covers all map space. Enlarging preserves current center of view if no 

limitation for enlarging exists. Limitation of enlarging applies on this operation in two directions 

independently. Field of limitation is all map space. 

 Shortcuts: Navigation Toolbar:  

Zoom out step :5 

Use this command to enlarge zoom field in 5 times in two directions. This command is unavailable if 

current field of zoom covers all map space. Enlarging preserves current center of view if no 

limitation for enlarging exists. Limitation of enlarging applies on this operation in two directions 

independently. Field of limitation is all map space. 

 Shortcuts: Navigation Toolbar:  
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Zoom out step :2 

Use this command to enlarge zoom field in 2 times in two directions. This command is unavailable if 

current field of zoom covers all map space. Enlarging preserves current center of view if no 

limitation for enlarging exists. Limitation of enlarging applies on this operation in two directions 

independently. Field of limitation is all map space. 

 Shortcuts: Navigation Toolbar:  

Zoom in step x2 

Use this command to collapse zoom field in 2 times in two directions. This command is unavailable 

if current field of zoom is same as minimal logical unit of map. The collapse preserves current center 

of view. 

 Shortcuts: Navigation Toolbar:  

Zoom in step x5 

Use this command to collapse zoom field in 5 times in two directions. This command is unavailable 

if current field of zoom is same as minimal logical unit of map. The collapse preserves current center 

of view. 

 Shortcuts: Navigation Toolbar:  

Zoom in step x10 

Use this command to collapse zoom field in 10 times in two directions. This command is unavailable 

if current field of zoom is same as minimal logical unit of map. The collapse preserves current center 

of view. 

 Shortcuts: Navigation Toolbar:  

Setup of region 

Use this command for setup bounding limits of selected region. Use the Region combo box to 

switch among the multiple existed regions. This command displays the Setup of region dialog box. 

You can create new region, if in Region combo box prompt for new region is selected. 

 Shortcuts: Navigation Toolbar:  

Delete region 

Use this command to delete selected region. This command is unavailable if selected region is not 

assigned (in Region combo box prompt for new region is selected). 

Select of Region 

This command activates and opens the Region combo box, which placed on Navigation Bar. 

Use the Region combo box for select desired region.  After selecting region in the combo box, all 

views are updated.  On top of list of the combo box, prompt for assigning new region is placed. 

 Shortcuts: Navigation Toolbar:   Keys: SHIFT+R 
 

20.5. Help menu. 

 

User manual… 
Use this command to show user manual for Spatial Aspect Explorer. 

Shortcuts: Keys: F1 
About Spatial Aspect Explorer… 
Use this command to display the copyright notice and version number of your copy of Spatial Aspect 

Explorer. 

 Shortcuts: Main Toolbar:  
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20.6. Context menu of project view. 

The context menu appears by clicking right button of mouse on Project view.  This menu brings for 

you commands for inspect and changing properties and information of entire project and its 

components. It has keyboard shortcut Shift+F10.  The context menu offers the following commands: 

 

Add layer… 

Adds layer to this vector map project. 

See the command description in Edit menu. 

Clone layer 

Use this command to clone current layer and add to this vector map project. 

The command included in Edit menu. 

Delete layer 

Deletes current layer from this vector map project. 

See the command description in Edit menu. 

Toggle layer 

Toggles rendering state of current layer. 

See the command description in Edit menu. 

Move layer 

Submenu from Edit menu: 

Move to Top 

Use this command to move current layer to top. 

Move Up 

Use this command to move current layer to up on one position. 

 Shortcuts: Keys: Shift+Up 
Move Down 

Use this command to move current layer to down on one position. 

 Shortcuts: Keys: Shift+Down 
Move to Bottom 

Use this command to move current layer to bottom. 

Layer properties…(default, for a layer’s entry selected) 

Customizes properties of current layer. 

Since it can be default entry in the menu, the command will be executed by double-click on a layer’s 

entry in tree. See the command description in Edit menu. 

LoD strategy… 

Defining strategy for Levels of Details (LoD) of current layer. 

See the command description in Edit menu. 

Shape info… 

Opens a listed view of shapes database info for inspection. 

See the command description in View menu. 

Map title… 

Edits title of the map. 

See the command description in Edit menu. 

Map limits… 

Changes limits of the map. 

See the command description in Edit menu. 

Background……(default, for the background’s entry selected) 

Customizes background. 

Since it can be default entry in the menu, the command will be executed by double-click on a 

background’s entry in tree. See the command description in Edit menu. 
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20.7. Context menu of map view. 

The context menu appears by clicking right button of mouse on image part of Main view or on 

Overview. This menu brings for you commands for changing any properties or executing any 

actions on those views. It has keyboard shortcut Shift+F10. The context menu offers the following 

commands: 

 

Selection & moving 

Switches to selection and moving mode of work with smart cursor. 

See the command description in Navigation menu. 

Selection & sizing 

Switches to selection and sizing mode of work with smart cursor. 

See the command description in Navigation menu. 

Magnify glass 

Switches to magnify glass mode. 

See the command description in Navigation menu. 

Smooth zoom 

Enables smooth zoom instead sizing. 

See the command description in Navigation menu. 

Zoom out step :10 

Zooms out with step :10 from current value. 

See the command description in Navigation menu. 

Zoom out step :5 

Zooms out with step :5 from current value. 

See the command description in Navigation menu. 

Zoom out step :2 

Zooms out with step :2 from current value. 

See the command description in Navigation menu. 

Zoom in step x2 

Zooms in with step x2 from current value. 

See the command description in Navigation menu. 

Zoom in step x5 

Zooms in with step x5 from current value. 

See the command description in Navigation menu. 

Zoom in step x10 

Zooms in with step x10 from current value. 

See the command description in Navigation menu. 

Shading 

Toggles rendering of shades on surface. 

See the command description in View menu. 

Shading only 

Toggles render only of shades on surface. 

See the command description in View menu. 

Color scale 

Switches between color scales from existed set. 

See the command description in View menu. 

Find range 

Finds and sets existed range of elevations. 

See the command description in View menu. 

Raster file properties… 

Use this command to view properties of raster file of the map in its background. 

The command included in File menu. 
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View to PNG… 

Use this command to save content of current view to PNG file. 

The command isn’t included in any other menu. 
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